
Bab V Standar Kompetensi: 5. Menggunakan perangkat lunak 
pengolah kata untuk menghasilkan informasi

Pengolah Kata
OpenOffice.org Writer 2.x

Pendahuluan OpenOffice.org

Mengenal OpenOffice.org dan Sejarahnya

OpenOffice.org  (selanjutnya  disingkat  dengan  istilah  OOo) 

merupakan salah satu paket software perkantoran (office suite) yang saat 

ini banyak beredar dan mulai populer di pasaran. Sejarah OOo dimulai dari 

StarOffice,  sebuah  paket  Office-suite komersial  yang  dibuat  oleh  Sun 

Mycrosystems, perusahaan perangkat lunak yang terkenal sebagai produsen 

programming software dan program-program aplikasi berbasis JAVA. Pada 

tahun  2000,  Sun  menyumbangkan  kode  program  StarOffice  kepada 

komunitas  Open-source, sejak saat itulah dimulai pengembangan  Office-

suite yang bersifat bebas (open-source sekaligus gratis) dan diberi nama 

OpenOffice.org. Saat itu Sun menjadi sponsor dan donatur utama proyek 

pengembangan OOo. Saat ini cukup banyak perusahaan yang mendukung 

pengembangan OOo, di antaranya Novell, Debian, RedHat dan salah satu 

perusahaan perangkat keras raksasa, Intel.

Gambar 5.1 Jendela sambutan OpenOffice.org 2.3

Setelah tujuh tahun dikembangkan dan sukses dengan versi 1.x, 

saat ini OOo memasuki versi 2.3 dengan tambahan fasilitas dan perubahan-

perubahan  yang  cukup  signifikan.  Perbedaan  yang  paling  utama  adalah 

masalah  tampilan  yang  semakin  mirip  dengan Microsoft  Office  sehingga 

memudahkan  pengguna  program  office-suite komersial  tersebut  untuk 

bermigrasi ke OOo. Selain itu mulai OOo versi 2.0 telah dilengkapi dengan 

program pembangun Basis Data yang disebut OOo Base dengan penggunaan 

yang tidak jauh berbeda dengan MS Access milik Microsoft.
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Selain kaya fasilitas di dalam programnya sendiri, OOo memiliki 

fitur-fitur  lain  yang tidak  dimiliki  program-program  office-suite sejenis, 

antara lain;

● OOo dapat dijalankan pada berbagai Sistem Operasi (OS) populer, 

yaitu  seluruh  varian  Linux,  BSD,  Microsoft  Windows,  MacOS  dan 

tentu saja Sistem Operasi milik Sun, Solaris. Artinya, bila pengguna 

berpindah dari satu OS ke OS yang lain, file hasil pengolahan OOo 

dapat tetap digunakan.

● Memiliki dukungan lebih dari 30 bahasa di dunia

● Kompatibel  dengan  program-program  MS  Office,  OOo  dapat 

menjalankan  file  hasil  pengolahan  MS  Word,  MS  Excel  dan  MS 

PowerPoint

● Kemampuan  untuk  konversi  ke  file  PDF  secara  langsung  tanpa 

memerlukan tambahan program lainnya

Aplikasi-aplikasi pada Paket OpenOffice.org

OOo menyertakan enam buah aplikasi utama, yaitu

● OOo Writer

Program Pengolah Kata sebagai alternatif MS Word

● OOo Calc

Program Lembar Kerja/Spreadsheet sebagai alternatif MS Excel

● OOo Impress

Program Presentasi sebagai alternatif MS PowerPoint

● OOo Base

Program Basis-Data (Database) sebagai alternatif MS Access

● OOo Draw

Program Pengolah Grafis Vektor sebagai alternatif Corel Draw

● OOo Math

Program Penyusun Formula sebagai alternatif MS Equation

Menjalankan Aplikasi OpenOffice.org

Langkah untuk menjalankan OOo tidak berbeda dengan program-

program lain yang berjalan pada sistem operasi MS Windows maupun Linux. 

Cara yang bisa dipilih untuk mulai bekerja dengan OOo sangat bergantung 

pada  pilihan  penempatan  shortcut pada  waktu  proses  instalasi.  Namun 

secara umum, salah satu cara yang hampir pasti bisa dipakai adalah dengan 

prosedur standar menjalankan program melalui langkah-langkah:
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Tabel 5.1 Menjalankan Program OOo pada OS Windows dan Linux

Pada MS Windows Pada Linux
● Klik menu “Start”

● Sorot “Programs” / “All 

Programs”

● Klik “OpenOffice.org”  

pilihan program yang akan 

dijalankan (Writer, Calc, 

Impress, Base, Draw atau 

Math)

● Klik menu “Launch/ / ” 

(tergantung desktop dan distro yang 

dipakai) pada taskbar

● Sorot “Application”, sorot 

“Office”/“Office Suite”

● Klik “OpenOffice.org”  pilihan 

program yang akan dijalankan (Writer, 

Calc, Impress, Base, Draw atau Math)

Gambar 5.2 Mulai menjalankan OooBase pada Sistem Operasi MS Windows XP

Gambar 5.3 Mulai menjalankan OOo Writer pada Sistem Operasi Linux-Knoppix 5.0.1

Salah satu keunikan OOo adalah kemampuan membuka aplikasi 

lain dalam paket OOo dengan cepat, pada jendela yang sama, saat suatu 

aplikasi sedang aktif. Contohnya; saat ini aplikasi yang sedang aktif adalah 

OOo Writer, di dalam jendela Writer kita dapat langsung membuka aplikasi 

lain seperti Calc, Base, Impress atau Draw. Caranya dengan meng-klik File 

> New, lalu pilih aplikasi yang diinginkan. Perhatikan gambar 5.4 di bawah 

Gambar 5.4 Memulai aplikasi berbeda langsung dari jendela OOo Writer

KTSP Standar Isi 2006 – Berbasis FOSS 3



Instalasi OpenOffice.org 2.x pada Sistem Operasi MS Windows

Pada  sebagian  besar  distribusi  Linux  terbaru,  OpenOffice.org 

biasanya sudah terintegrasi. Kelebihan OOo adalah mampu bekerja multi-

platform, sehingga memungkinkan untuk dijalankan lintas Sistem Operasi. 

Pada Windows, proses instalasi dimulai dengan menjalankan file instalasi 

seperti ditunjukkan pada gambar 5.5 (file tersedia di CD)

Gambar 5.5 Ikon file instaler OOo 2.3 pada MS Windows

Untuk memulai proses instalasi OOo, klik ganda pada file instaler, 

tunggu beberapa saat dan ikuti langkah-langkah pada tabel 5.2 

Gambar 5.6 Loading proses instalasi

Tabel 5.2 Kotak dialog Langkah-langkah instalasi OpenOffice.org

1.
Pada Tahap Pendahuluan dijelaskan 
bahwa kotak dialog yang akan muncul 
berikutnya adalah untuk instalasi OOo. 
Klik Next untuk melanjutkan

2.
Pilih Lokasi untuk mengekstrak file-file 
instalasi. Klik Unpack untuk 
melanjutkan

3.
Tunggu hingga proses ekstraksi file-file 
instalasi selesai
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4.
Selanjutnya akan ditampilkan Dialog 
Selamat Datang. Klik Next untuk 
melanjutkan

5.
Pada layar persetujuan lisensi, bacalah 
dengan cermat isi perjanjiannya, lalu 
tandai pilihan “I accept the terms in 
the license agreement”. Klik Next 
untuk melanjutkan

6.
Masukkan nama dan organisasi user. 
Klik Next untuk melanjutkan

7.
Pada dialog pemilihan tipe setup, pilih 
Complete untuk menginstal seluruh 
program pada paket OOo, Klik Next 
untuk melanjutkan

8.
Bila pada Windows telah ada paket MS 
Office, dialog ini sebaiknya dilalui, 
namun bila tidak ada, beri centang 
pada ketiga pilihan tersebut, dengan 
demikian bila nantinya terdapat file-
file Word (*.doc), Excel (*.xls) dan 
Powerpoint (*.ppt) otomatis dibuka 
dengan Writer, Calc dan Impress. Klik 
Next untuk melanjutkan

9.
Setelah selesai melakukan pengaturan 
seperlunya, Proses instalasi dapat 
dimulai. Klik Install untuk melanjutkan 
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10.
Tunggu hingga proses instalasi selesai 
dilakukan

11.
Klik Finish untuk mengakhiri proses 
instalasi

Saat  pertama  kali  bekerja  dengan  OOo,  kita  akan  diminta 

menyetujui ketentuan-ketentuan lisensi dan melakukan registrasi dengan 

langkah-langkah sebagai berikut

Tabel 5.2 Kotak dialog Langkah-langkah instalasi OpenOffice.org

1.
Pada jendela sambutan, klik Next >> 
untuk melanjutkan

2.
Baca baik-baik lisensi GPL pada 
kolom lisensi hingga akhir dengan 
menekan tombol Scroll Down atau 
arahkan ruler hingga bagian akhir 
lisensi, klik Accept untuk menyetujui 
Perjanjian lisensi tersebut

3.
Isikan nama pengguna program, klik 
Next >> untuk melanjutkan
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4.
Pada jendela “Online Updates” beri 
tanda centang pada pilihan Check 
for updates automatically bila ingin 
mendapatkan update dari OOo secara 
otomatis melalui internet, pilihan ini 
bisa dilewati, klik Next >> untuk 
melanjutkan

5.
Pada bagian “Registration” tentukan 
pilihan registrasi pengguna program, 
untuk menghindari kerumitan, kita 
bisa memilih “I do not want to 
register” , klik Finish untuk 
mengakhiri proses registrasi

Kompetensi Dasar :
5.1 Menunjukkan menu ikon yang terdapat dalam perangkat lunak 

pengolah kata

Mengaktifkan Program Pengolah Kata OOo Writer

Untuk  mengaktifkan  OOo  Writer  pada  OS  M  Windows  dapat 

dilakukan  dari  menu  Start >  All  Programs >  OpenOffice.org  2.3 > 

OpenOffice.org Writer.

Gambar 5.7 Memulai OOo Writer pada menu start MS Windows

Menu dan Ikon pada OOo Writer

Mengidentifikasi Menu dan Ikon

Untuk  menunjang  kerja,  OOo  Writer  menyediakan  perintah-

perintah  yang  berkaitan  dengan  pengolahan  kata.  Perintah-perintah 

tersebut dirangkum dalam bentuk menu  pull-down maupun  toolbar yang 

terdiri dari ikon-ikon.
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Indikator Pencapaian:

Menjelaskan pengertian 
menu dan ikon yang 
terdapat dalam 
perangkat lunak 
pengolah kata

Menerangkan fungsi 
menu dan ikon yang 
terdapat dalam 
perangkat lunak 
pengolah kata

Mengidentikasi menu 
dan ikon yang terdapat 
dalam perangkat lunak 
pengolah kata

Menampilkan menu dan 
ikon yang tersembunyi 
dan menyembunyikan 
ikon-ikon yang tidak 
diperlukan  



Gambar 5.8 Lembar Kerja OOo Writer

Evaluasi Sikap 5.1:
Tugas Individu

a. Bukalah program OOo Writer dan perhatikan Gambar 5.8
b. Tuliskan pada buku tugas; fungsi masing-masing bagian yang 

ditunjukkan pada gambar 5.8 

Elemen-elemen pada baris menu

Baris  menu  merupakan  fasilitas  yang  disediakan  oleh  hampir 

setiap program secara default. Baris menu biasanya terdapat di bagian atas 

jendela program, di bawah baris judul. Menu pada OOo Writer terdiri dari 

File,  Edit,  View,  Insert,  Format,  Table,  Tools,  Window dan  Help. Baris 

menu berbentuk  pull-down,  untuk mengaktifkannya klik pada salah satu 

menu, lalu pilih menu-menu lain di dalamnya.

Gambar 5.9 Mengaktifkan menu File
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Area Kerja 
Dokumen

Baris Menu

Toolbar Standard

Toolbar Formatting

Baris status

Tombol Ukuran

Baris Judul

Mistar

Ruler

TIPS

Untuk mengaktifkan 
menu, dapat juga 

dilakukan melaluijalan 
pintas (short-cut) pada 

tombol keyboard berupa 
kombinasi tombol Alt + 

huruf-yang-digaris-
bawah-pada-menu.

Contoh: menu File dapat 
diaktifkan dengan 

kombinasi tombol Alt+F



Evaluasi Sikap 5.2:
Tugas Individu

● Bukalah program OOo Writer
● Rangkumlah pada buku tugas;

isi dan fungsi dari menu File dan Format.

Elemen-elemen Toolbar

Secara default, OOo Writer menyediakan dua jenis toolbar, yaitu 

Standard dan Formating, namun kita juga bisa menambahkan toolbar yang 

lain  melalui  menu  View >  Toolbar,  lalu  beri  tanda  centang  pada  jenis 

toolbar yang ingin ditampilkan.

Gambar 5.10 Menu untuk menampilkan toolbar lain pada jendela OOo Writer

Pada  masing-masing  toolbar  terdapat  ikon-ikon  yang  mewakili 

perintah  tertentu,  toolbar standard mengumpulkan  ikon-ikon  yang 

mewakili perintah-perintah dasar seperti membuka, menutup, menyimpan 

file dan sebagainya. Sedangkan toolbar formatting  menyediakan ikon-ikon 

yang berfungsi melakukan format terhadap teks dan paragraf

Gambar 5.11 Toolbar standard dan formatting
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Evaluasi Sikap 5.3:
Tugas Individu

• Perhatikan gambar 5.11
• Bukalah program OOo Writer
• Tuliskan pada isian di bawah ini; fungsi dari masing-masing ikon 

yang ditandai dengan nomor 1 – 20.

1. ..........................................................................

2. ..........................................................................

3. ..........................................................................

4. ..........................................................................

5. ..........................................................................

6. ..........................................................................

7. ..........................................................................

8. ..........................................................................

9. ..........................................................................

10. ..........................................................................

11. ..........................................................................

12. ..........................................................................

13. ..........................................................................

14. ..........................................................................

15. ..........................................................................

16. ..........................................................................

17. ..........................................................................

18. ..........................................................................

19. ..........................................................................

20. ..........................................................................

Kompetensi Dasar :
5.2 Menggunakan menu ikon yang terdapat dalam perangkat lunak 

pengolah kata

Bekerja dengan dokumen OOo Writer

Membuat dokumen baru

Pada saat kita membuka program OOo Writer secara default akan 

ditampilkan  sebuah  dokumen  baru  berupa  halaman  kosong.  Sedangkan 

langkah umum untuk membuat sebuah dokumen baru pada program yang 

sedang aktif adalah dengan memilih ikon  pada  toolbar.  Selain itu 

bisa pula melalui shortcut kombinasi tombol Ctrl+N pada keyboard.
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Indikator Pencapaian:

Mengelola dokumen 
pada program pengolah 

kata

Memodifikasi jenis dan 
pengaturan pada teks

Memodifikasi 
pengaturan halaman

Mendemonstrasikan 
pembuatan mail-merge



Menyimpan dokumen

Ada tiga skenario penyimpanan file pada dokumen OOo. Untuk 

menyimpan  dokumen  pada  saat  pertama  kali  dibuat  (belum  pernah 

disimpan sama sekali)  bisa dilakukan dengan memilih menu  File >  Save 

atau  klik  ikon   pada  toolbar.  Selain  itu  bisa  pula  melalui  shortcut 

kombinasi  tombol  Ctrl+S pada  keyboard.  Ketiga  langkah  ini  akan 

menghasilkan efek yang sama dengan memilih menu File > Save As....

Lalu pilih tempat penyimpanan melalui kolom Save in dan nama 

file yang akan disimpan pada kolom File  name. Secara  default, program 

OOo Writer akan menyimpan file dalam format OpenDocument Text (*.odt). 

Namun Writer juga mengijinkan kita untuk menyimpan file dalam format 

program pengolah kata lainnya, termasuk Microsoft Office Word (*.doc). 

Untuk  menyimpan  file  dalam  format  selain  ODT,  dapat  dipilih  melalui 

kolom Save as type.

Gambar 5.12 Jendela konfirmasi penyimpanan file

Skenario kedua adalah menyimpan dokumen yang sedang aktif 

dan sebelumnya sudah pernah disimpan. Penyimpanan dilakukan melalui 

mekanisme  Save.  Pada  skenario  kedua  tidak  akan  dikonfirmasi  lagi 

mengenai nama, tempat penyimpanan dan format file seperti ditunjukkan 

pada gambar 5.12.

Sedangkan skenario terakhir adalah menyimpan file yang sudah 

disimpan namun ingin disimpan lagi  dengan nama yang berbeda atau di 

tempat lain atau dengan format yang berbeda, skenario ini hanya dapat 

dilakukan dengan mekanisme  Save As. Prosedur selanjutnya adalah sama 

dengan skenario pertama.
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Evaluasi Praktik 5.1:
Tugas Kelompok (2 siswa)

• Buatlah sebuah file baru pada OOo Writer
• Tuliskan puisi di bawah ini, gunakan ikon-ikon yang telah kalian 

pelajari pada Evaluasi Praktik 5.3

Resah Jiwa Malam
Karya: Wibisono Sukmo Wardhono

Di hari yang lelah
Di penantian yang resah

Raga terjaga
Di jiwa yang tak bertenaga

Hamparan malam merajut kalam
Terjebak diam lalui kelam

• Simpanlah dengan nama praktik51 dalam format default Writer.
• Simpan juga dengan nama praktik51 dalam format MS Word

NB: Simpanlah kedua buah file tersebut pada direktori /home 

Menutup File dan Program OOo Writer

Untuk menutup file yang sudah disimpan tanpa menutup program 

OOo  Writer  secara  keseluruhan,  dapat  dilakukan  dengan  menekan 

kombinasi tombol Control+W. Selain itu bisa juga dengan menekan tombol 

[x] pada bagian dalam jendela program.

Gambar 5.13 Tombol [x] di bagian bawah berfungsi untuk menutup file dan tombol [x] di  
bagian atas berfungsi untuk menutup program OOo Writer

 Sedangkan  untuk  menutup  program  OOo  Writer  secara 

keseluruhan dapat dilakukan dengan menekan tombol [x] pada bagian luar 

jendela program atau dengan menekan kombinasi tombol Control-Q.

Bila  file  belum disimpan  maka  OOo Writer  akan menampilkan 

jendela konfirmasi seperti ditunjukkan pada gambar 5.14. Klik Save untuk 

menyimpan, Discard untuk mengabaikan penyimpanan dan tetap munutup 

program serta Cancel untuk membatalkan penutupan.

Gambar 5.14 Jendela konfirmasi untuk file yang belum disimpan
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Membuka File Hasil  Pengolahan Data OOo Writer

File  Hasil  pengolahan  data  OOo  Writer  dapat  dibuka  melalui 

beberapa  jalan.  Di  antaranya  dapat  dibuka  langsung  melalui  jendela 

penjelajah file, seperti Windows Explorer pada OS MS Windows. Untuk file 

default OOo Writer (berekstensi *.odt), kita dapat membuka file tersebut 

dengan cara klik ganda di atas ikon file tersebut. 

Gambar 5.15 File default hasil pengolahan OOo Writer

Sedangkan  file  hasil  pengolahan  program  pengolah  kata  lain 

dapat pula dibuka dengan OOo Writer  dengan klik-kanan pada ikon file 

tersebut, sorot bagian Open With, lalu klik swriter.

Gambar 5.16 File hasil pengolahan MS Office Word dibuka menggunakan OOo Writer

Mengekspor File Pengolahan Kata Sebagai File PDF

Salah satu keunggulan Ooo Writer dibanding program pengolah 

kata lainnya adalah kemampuannya meng-ekspor file ke dalam bentuk PDF, 

sehingga nantinya file yang kita buat dapat dibaca di berbagai platform 

dengan program-program pembaca file  PDF seperti  Adobe Reader,  Foxit 

Reader dan sebagainya. Ekspor file dapat dilakukan melalui menu  File > 

Export as PDF. Selain itu bisa pula melalui klik ikon  pada taskbar.
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Mencetak Dokumen

Untuk mencetak file Writer, klik menu File > Print, atau melalui 

kombinasi ringkas Control+P pada keyboard. selanjutnya akan ditampilkan 

jendela pencetakan seperti pada gambar 5.17.

Gambar 5.17 Jendela pengaturan atribut pencetakan

Melalui jendela tersebut bisa diatur pilihan halaman yang akan 

dicetak, sekaligus dengan pengaturan jumlah cetakan yang akan dibuat. 

Untuk pengaturan  lainnya klik tombol  Properties,  klik  tombol  OK untuk 

mulai mencetak dokumen. Selain itu bisa pula melalui klik ikon  pada 

taskbar, namun dengan cara ini pencetakan tidak bsa diatur, Writer akan 

langsung mencetak seluruh halaman pada dokumen sebanyak satu kali.

Melihat Tampilan Cetakan (Preview)

Untuk melihat tampilan dokumen sebelum dicetak klik menu File 

> Page preview, atau melalui klik ikon  pada taskbar.

Gambar 5.18 Tampilan Page preview
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Pengaturan Teks

Format Karakter

Pengaturan karakter berfungsi untuk menentukan jenis, bentuk, 

posisi dan latar belakang font, serta penentuan hyperlink. Format karakter 

dilakukan  melalui  menu  Format >  Character.  Selanjutnya  akan  muncul 

jendela seperti ditunjukkan pada gambar 5.17.

Gambar 5.19 Jendela pengaturan karakter pada tab Font

Evaluasi Sikap 5.4:
Tugas Individu

• Perhatikan gambar 5.19
• Tuliskan pada isian di bawah ini; fungsi dari masing-masing bagian

Font

Typeface

Size

Language

Bila  tab  Font  Effects di-klik,  akan  ditampilkan  bagian-bagian 

yang  berfungsi  untuk  mengatur  bentuk-bentuk  dan efek-efek  dari  font, 

perhatikan  tampilannya  pada  gambar  5.18.  Sedangkan  tab  Position 

mengatur penempatan posisi teks, tampilannya ditunjukkan pada gambar 

5.21. Tab berikutnya adalah  Hyperlink, yang berfungsi memasukkan link 

(sambungan) pada suatu teks menuju halaman tertentu di  internet. Tab 

yang  terakhir,  yaitu  Background,  berfungsi  untuk  menambahkan  latar 

belakang warna pada suatu teks seperti pada tulisan ini .
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Gambar 5.20 Jendela pengaturan karakterpada tab Font Effects

Evaluasi Sikap 5.5:
Tugas Individu

• Perhatikan gambar 5.20
• Tuliskan pada isian di bawah ini; fungsi dari masing-masing bagian

Underlining

Strikethrough

Font color

Effects

Gambar 5.21 Jendela pengaturan karakterpada tab Position

Evaluasi Sikap 5.6:
Tugas Individu

• Perhatikan gambar 5.21
• Tuliskan pada isian di bawah ini; fungsi dari masing-masing bagian

Position

Rotation/Scaling

Spacing
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Evaluasi Praktik 5.2:
Tugas Kelompok (2 siswa)

• Buatlah sebuah file baru pada OOo Writer
• Tuliskan rangkaian rumus di bawah ini dengan jenis font bebas dan 

ukuran font 12pt, gunakan macam-macam pengaturan teks yang 
telah kalian pelajari pada Evaluasi Sikap 5.4 – 5.6

Dari sebuah fungsi f(x) = ax2 + bx + c, tentukan nilai x agar f(x) = 0, bila 
diketahui

a = 1; b = -6 ; c = 8

Penyelesaian:

x1-2 = (-b + (b2 – 4.a.c)1/2) / 2.a

x1-2 = (6 + ((-6)2 – 4.1.8)1/2) / 2.1
x1-2 = (6 + (36 - 32)1/2) / 2
x1-2 = (6 + 41/2) / 2 = (6 + 2) / 2
x1 = (6 + 2) / 2 = 8 / 2
x2 = (6 – 2) / 2 = 4 / 2

maka x1 = 4 atau x2 = 2

Hitunglah hasil dari pembagian faktorial 7! / 5!

Penyelesaian:

7! =  7 x 6 x 5 x 4 x 3 x 2 x 1
5! =  5 x 4 x 3 x 2 x 1
7! / 5! = 7 x 6 x 5 x 4 x 3 x 2 x 1 /  5 x 4 x 3 x 2 x 1
7! / 5! = 7 x 6 = 42

maka 7! / 5! = 42

• Simpanlah dengan nama praktik52 pada direktori /home 

Bulleting dan Numbering

Bulleting dan Numbering digunakan untuk membuat daftar (list). 

Untuk menggunakannya, tempatkan krusor pada bidang kosong yang akan 

diisi daftar, lalu klik menu Format > Bullets and Numbering. Selanjutnya 

akan ditampilkan jendela pengaturan Bullets seperti tampak pada gambar 

5.20. Pilih jenis bullet yang diinginkan, lalu klik OK untuk mulai membuat 

daftar  dengan  menggunakan  bullet tersebut.  Pilihan  bullet  lain  dengan 

bentuk yang lebih menarik bisa dicoba pada tab Graphics.
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Gambar 5.20 Jendela pengaturan bullet

Sedangkan untuk pengaturan numbering dapat dilakukan dengan 

memilih tab Numbering type.

Gambar 5.21Jendela pengaturan numbering

Untuk pembuatan daftar berjenjang dilakukan dengan memilih 

tab Outline seperti ditunjukkan pada gambar 5.22.

Gambar 5.22Jendela pengaturan outline
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Untuk mengatur ukuran bullet, jarak spasi, tanda pemisah, jarak 

outline serta  pengaturan  opsional  lainnya  dapat  dilakukan  melalui  tab 

Position dan Options.

Selain melalui menu, pengaturan bulleting dan numbering dapat 

juga  dilakukan melalui  ikon-ikon  pada toolbar  seperti  ditunjukkan pada 

gambar 5.23.

Gambar 5.23 Ikon-ikon pengatur bullets and numbering

Evaluasi Praktik 5.3:
Tugas Kelompok (2 siswa)

• Buatlah sebuah file baru pada OOo Writer
• Tuliskan daftar di bawah ini

Materi TIK tingkat SMA
● Kelas X

 1.1 Semester 1
 1.1.1 Operasi Dasar TIK
 1.1.2 Perangkat TIK
 1.1.3 Ketentuan Penggunaan Perangkat TIK

 1.2 Semester 2
 1.2.1 Sistem Operasi
 1.2.2 Pengolah Kata

● Kelas XI
 2.1 Semester 1

 2.1.1 Internet
 2.2 Semester 2

 2.2.1 Pengolah Tabel Angka
● Kelas XII

 3.1 Semester 1
 3.1.1 Pengolah Grafik

 3.2 Semester 2
 3.2.1 Presentasi

• Simpanlah dengan nama praktik53 pada direktori /home 

Menyisipkan simbol (karakter khusus)

Untuk menyisipkan simbol pada isi naskah, letakkan krusor pada 

lokasi yang diinginkan, klik menu Insert >  Special Character. Selanjutnya 

akan muncul  jendela seperti  ditampilkan  pada gambar 5.24.  Pilih  salah 

satu simbol yang diinginkan, lalu klik OK.
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Gambar 5.24 Jendela untuk menyisipkan smbol (karakter khusus)

Mencari dan Mengganti Kata

Ada  kalanya  ketika  kita  membuka  suatu  naskah,  kita  perlu 

mencari  satu  bagian  dengan  kata-kata  maupun  kalimat  tertentu,  atau 

bahkan kita ingin mengganti suatu kata di seluruh bagian naskah dengan 

kata lain. Untuk keperluan tersebut OOo Writer menyediakan fasilitas yang 

bisa diakses melalui menu Edit > Find & Replace.

Gambar 5.25 Jendela untuk mencari dan mengganti dan mengganti kata (kalmat)

Untuk mencari suatu kata (kalimat), cukup isikan bagian Search 

for dengan kata (kalimat) yang ingin dicari, lalu klik  Find untuk mencari 

satu  per  satu.  Bila  ingin  mengumpulkan  seluruh  kata,  klik  Find  All. 

Sedangkan untuk mengganti kata (kalimat), isikan kata (kalimat) yang akan 

diganti pada bagian Search for dan masukkan kata (kalimat) penggantinya 

pada   bagian  Replace with. Untuk mengganti satu per satu, klik tombol 

Replace atau klik Replace All untuk mengganti semua kata (kalimat) pada 

bagian search dengan kata (kalimat) penggantinya. 
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Pengaturan Format Paragraf

Pengaturan paragraf secara umum dapat diakses melalui  menu 

Format >  Paragraph.  Namun  beberapa  fasilitas  dapat  diakses  secara 

langsung melalui ikon-ikon yang terdapat pada toolbar.

Mengatur Indentasi

Agar tertata dengan rapi dan memenuhi kaidah penulisan suatu 

naskah, maka bentuk paragraf perlu diatur dengan memanfaatkan fasilitas 

pembatas (indentasi)  yang tersedia di  bagian atas dokumen. Pengaturan 

indentasi  ini  dapat  dilakukan  dengan  menggunakan  teknik  drag  'n  drop 

pada mouse.

Gambar 5.26 Indentasi bagian kiri, segitiga bagian atas menandai awal paragraf, sedangkan 
bagian bawahnya menunjukkan batas kiri paragraf

Gambar 5.27 Indentasi bagian kanan menandai batas akhir kalimat-kalimat di dalam 
paragraf

Menentukan Orientasi Perataan Paragraf

Perhatikan rangkaian toolbar pada gambar 5.28

Gambar 5.28 Ikon untuk memilih orientasi perataan

Berurutan  dari  kiri  ke  kanan  adalah  ikon  untuk  meratakan 

paragraf di bagian kiri, tengah, kanan dan kiri-kanan (justified).
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Mengatur Jarak Spasi Paragraf

Jarak  paragraf  dapat  diatur  melalui  jendela  menu pengaturan 

paragraf. Melalui tab  Indents & Spacing, pilihlah jarak spasi pada bagian 

Spacing.

Gambar 5.29 Jendela pengaturan paragraf, bagian yang dilingkari merupakan tempat  
pengaturan spasi di dalam paragraf

Membuat Drop Caps

Drop Caps merupakan sebuah fasilitas untuk membesarkan huruf 

atau  kata(-kata)  pertama  di  suatu  paragraf  sebesar  ukuran  baris  yang 

diinginkan.  Untuk  membuat  drop  caps,  perhatikan  contoh  paragraf  di 

bawah ini.

Aku ingin mencintaimu dengan sederhana: Dengan kata yang tak sempat 
diucapkan.  Kayu  kepada  api  yang  menjadikannya  abu.  Aku  ingin 
mencintaimu  dengan  sederhana:  Dengan  isyarat  yang  tak  sempat 
disampaikan. Awan kepada hujan yang menjadikannya tiada
dari: AKU INGIN (Sapardi Djoko Damono)

Bloklah bagian yang akan dibuat sebagai drop caps seperti contoh 

di atas (pada tulisan “Aku”). Lalu klik menu Format > Paragraph. Pilihlah 

tab Drop Caps, lalu berilah tanda centang pada bagian Display drop caps. 

Pilihan  ini  akan  menghasilkan  drop  caps  pada  huruf  “A”,  untuk 

menghasilkan drop caps pada tulisan “Aku”, berilah tanda centang juga 

pada bagian Whole word. Pada bagian Lines, masukkan jumlah baris yang 

akan dijadikan ukuran drop caps. Dalam contoh ini akan dibuat drop caps 

sebesar dua baris
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Gambar 5.30 Ikon untuk memilih orientasi perataan

Perhatikan hasil drop caps pada kata “Aku” di bawah ini

 ingin mencintaimu dengan sederhana: Dengan kata yang tak 
sempat diucapkan. Kayu kepada api yang menjadikannya abu. 

Aku ingin mencintaimu dengan sederhana: Dengan isyarat yang tak sempat 
disampaikan. Awan kepada hujan yang menjadikannya tiada

Aku
dari: AKU INGIN (Sapardi Djoko Damono)

Evaluasi Praktik 5.4:
Tugas Kelompok (2 siswa)

• Buatlah sebuah file baru pada OOo Writer
• Tuliskan penggalan artikel di bawah ini menggunakan font Arial 

ukuran 12.
FOSS pada Kurikulum TIK SMA

(Teknologi  Informasi  dan  Komunikasi)  merupakan  mata-
pelajaran yang telah dimasukkan ke dalam Kurikulum SMA 
semenjak tahun 2004, tepatnya pada saat diberlakukannya 

Kurikulum Berbasis  Kompetensi  (KBK).  Hal  ini  tentunya menjadi  sebuah 
langkah maju bagi dunia pendidikan di Indonesia untuk membekali para 
siswa dalam menghadapi era informasi yang semakin berkembang.

TIK
Masalah  besar  yang  cukup  serius  dihadapi  oleh  kebanyakan 

sekolah, terutama sekolah-sekolah yang tidak memiliki dana cukup besar 

dalam penyediaan  perangkat  keras  maupun  perangkat  lunak  komputer. 

Tuntutan menggunakan program legal adalah sebuah tantangan tersendiri. 

Sebagaimana kita tahu, program-program komersial harganya mahal.

Solusi atas permasalahan ini adalah penggunaan program-program 

bebas, atau yang terkenal dengan sebutan FOSS (Free and Open Source 

Software).  Dengan  digunakannya  program  bebas,  kita  tidak  terbebani 

biaya yang tinggi, sekaligus mendukung gerakan anti program bajakan.

Disusun oleh: Wibisono Sukmo Wardhono, ST

• Simpanlah dengan nama praktik54 dalam format default Writer
pada direktori /home 
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Evaluasi Praktik 5.5 dan Sikap 5.7:
Tugas Individu

• Perhatikan paragraf yang telah kalian buat pada Praktik 5.4
• Letakkanlah krusor pada paragraf ketiga
• Lakukanlah perintah singkat (shortcut) yang tertulis pada kolom 

bagian kiri tabel di bawah ini, dan di kolom bagian kanan tuliskan 
apa yang terjadi pada paragraf tersebut

Ctrl-J

Ctrl-E

Ctrl-R

Ctrl-L

Pengaturan Format Halaman

Ada  sebuah  perbedaan  yang  cukup  signifikan  mengenai 

pengaturan  halaman  di  OOo  Writer  dengan  MSO  Word.  Bila  MSO  Word 

menempatkannya di menu  File >  Page Setup, OOo Writer menempatkan 

pengaturan halaman di menu yang lebih logis, yaitu Format > Page. Untuk 

mengatur format halaman kertas, klik tab Page.

Gambar 5.31 Jendela Pengaturan Halaman pada tab Page

Pengaturan Ukuran Kertas

Secara default, Writer menetapkan ukuran kertas sesuai dengan 

standar  pada  setting  regional  Sistem Operasi  (OS).  Bila  OS  diset  pada 

pilihan regional Indonesia, maka ukuran standarnya adalah A4 (21 x 29,7 

cm).  Untuk  mengubah  ukurannya,  pilih  jenis  kertas  yang  sesuai  pada 

bagian  Paper format >  Format. Bila pilihan kertas yang dicari tidak ada, 

ubahlah  ukurannya  secara  manual  pada  bagian  Width dan  Height, 

ukurannya bisa dalam cm maupun inci.
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TIPS & TRIK

Untuk membuat ukuran 
FOLIO pada pengaturan 

halaman, isikan 8,5in 
pada bagian width dan 

pada bagian height 
isikan 13in.



Pengaturan Orientasi Kertas

Orientasi  default kertas  adalah  portrait atau  tegak  vertikal. 

Untuk  mengganti  orientasi  kertas  menjadi  horizontal,  klik-lah  pilihan 

Landscape pada bagian Orientation.

Pengaturan Margin

Margin merupakan jarak antara tepi kertas dengan tulisan pada 

kertas. Untuk mengatur lebar margin, pada bagian Margins, tulislah jarak 

yang diinginkan pada masing-masing isian  Left,  Right,  Top dan  Bottom, 

dalam satuan cm maupun in (inci).

Membuat Header dan Footer

Header merupakan fasilitas pada program pengolah kata untuk 

menempatkan tulisan secara berulang di bagian atas halaman. Sedangkan 

footer fungsinya sama, namun letaknya di bagian bawah halaman. 

Pembuatan  header  dan  footer  juga  dilakukan  melalui  jendela 

menu pengaturan halaman. Untuk memasukkan  header atau  footer,  klik 

tab  Header atau  Footer,  lalu  berilah  tanda  centang  pada  pilihan 

Header/Footer on. Aturlah bagian yang lain untuk mengganti setting-nya, 

atau biarkan saja bila pengaturan default dari Writer sudah sesuai.

Gambar 5.32 Mengatur header melalui format halaman

Gambar 5.33 Mengatur footer melalui format halaman
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Selain  itu  header dan  footer bisa juga  dibuat  melalui  menu 

Insert >  Header/Footer > klik  Default. Dengan langkah ini, maka  header 

atau footer akan di-set default.

Menyisipkan Nomor Halaman pada Header/ Footer

Untuk  memasukkan  nomor  halaman  pada  header/  footer, 

letakkan  krusor  pada  bagian  yang  diinginkan,  lalu  pilih  menu  Insert > 

Fields >  Page  Number.  Hasil  pengaturan  header,  footer dan  nomor 

halaman ditunjukkan pada gambar 5.34

Gambar 5.34 Contoh hasil penggunaan header dan footer

Evaluasi Praktik 5.6 dan Sikap 5.8:
Tugas Individu

• Buatlah sebuah file Writer sebanyak 2 halaman seperti pada gambar 
5.34

• Aturlah ukuran kertasnya 15 cm X 20 cm dengan orientasi 
landscape.

• Tetapkan margin atas-kanan-bawah 1,5 cm dan margin kiri 2 cm.
• Buatlah header dan footer seperti pada contoh gambar 5.34.
• Materi yang kalian tuliskan bebas, namun kalian juga bisa 

menggunakan materi seperti pada gambar 5.34
• Simpanlah dengan nama praktik56 dalam format default Writer

pada direktori /home

Membuat Daftar Halaman (Table of Content - TOC)

Dalam menyusun naskah dengan banyak halaman seperti buku, 

karya ilmiah, skripsi dan sebagainya, daftar isi memegang peranan penting 

untuk  memudahkan  pembaca  mencari  bagian  tertentu  pada  naskah 

tersebut.  Writer  menyediakan  fasilitas  pembuatan  daftar  isi  otomatis. 

Untuk membuat Daftar Isi, perhatikan langkah-langkah di bawah ini.
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Persiapkan naskah yang akan dibuat Daftar Isi-nya, lalu sorot dan 

blok-lah kata-kata yang akan dimasukkan ke Daftar Isi  (biasanya berupa 

judul mupun sub-judul). Perhatikan gambar 5.35.

Gambar 5.35 Bagian yang disorot akan masuk ke dalam Daftar Halaman

Selanjutnya  klik  menu  Insert >  Indexes  And  Table >  Entry. 

Selanjutnya akan muncul jendela sepert ditunjukkan pada gambar 5.36.

Gambar 5.36 Bagian yang disorot akan masuk ke dalam Daftar Halaman

Pada bagian  Index pilih  Table of Content,  pada bagian  Entry 

pastikan isinya sudah sesuai dengan tulisan yang akan masuk ke Daftar Isi. 

Sedangkan  pada  bagian  Level,  isikan  1,  karena  tulisan  yang  akan 

dimasukkan (Kelas X – Semester 1) adalah bagian utama. Selanjutnya klik 

Insert dan Close. Lakukan hal yang sama untuk judul/ sub-judul lainnya, 

perhatikan juga levelnya.

Untuk menempatkan daftar isi  sesuai dengan masukan di atas, 

klik  krusor  pada halaman yang dituju.  Klik  menu  Insert >  Indexes And 
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Table >  Indexes and Table sampai muncul jendela seperti pada gambar 

5.37.

Gambar 5.37 Jendela penentu isian Daftar Isi

Isi  bagian  Title dengan  Daftar  Isi.  Lalu  klik  OK,  hasilnya 

ditunjukkan pada gambar 5.38. 

Gambar 5.38 Daftar Isi yang telah jadi
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TIPS

Agar Daftar Halaman 
lebih rapi dan mudah 

ditata, blok seluruh 
bagian berlatar-belakang 
abu-abu seperti tampak 

di gambar 5.38. Lalu 
buatlah halaman baru 

yang terpisah, dan 
paste-lah di bagian itu, 

kemudian editlah seperti 
biasa pada


